NOAA NESDIS
CENTER for SATELLITE APPLICATIONS and RESEARCH

DOCUMENTATION GUIDELINE

DG-1.1
ALGORITHM THEORETICAL BASIS DOCUMENT GUIDELINE
Version 3.0
TITLE: DG-1.1: ALGORITHM THEORETICAL BASIS DOCUMENT GUIDELINE VERSION 3.0

AUTHORS:

Phil Ardanuy (Raytheon Information Solutions)
Ken Jensen (Raytheon Information Solutions)

**ALGORITHM THEORETICAL BASIS DOCUMENT GUIDELINE VERSION HISTORY SUMMARY**

<table>
<thead>
<tr>
<th>Version</th>
<th>Description</th>
<th>Revised Sections</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>New Documentation Guideline adapted from EOS and NPOESS documents by Philip Ardanuy (Raytheon Information Solutions)</td>
<td>New Document</td>
<td>05/05/2006</td>
</tr>
<tr>
<td>1.1</td>
<td>Revisions by Ken Jensen (Raytheon Information Solutions). Added Section 3; re-numbered later sections. Added Section 5.5; re-numbered later section 5 subsections. Applied standard style to entire document.</td>
<td>All</td>
<td>06/02/2006</td>
</tr>
<tr>
<td>2.0</td>
<td>Revised by Ken Jensen (Raytheon Information Solutions) for version 2. Minor revisions to References. Removed Section 3; re-numbered later sections.</td>
<td>2</td>
<td>10/12/2007</td>
</tr>
<tr>
<td>3.0</td>
<td>Revised by Ken Jensen (Raytheon Information Solutions) for version 3.</td>
<td>1, 2</td>
<td>10/1/2009</td>
</tr>
</tbody>
</table>
B.1  Cover Page Template: ................................................................. 22
B.2  Document Header Template: ...................................................... 23
B.3  Document Cover Page Footer Template: ...................................... 23
B.4  Document Footer Template: ....................................................... 23
B.5  Version History Page Template: ................................................ 24
B.6  Figure Caption Template: .......................................................... 26
B.7  Table Title Template: ............................................................... 26
B.8  List of References Template: .................................................... 27
# LIST OF ACRONYMS

<table>
<thead>
<tr>
<th>Acronym</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ATBD</td>
<td>Algorithm Theoretical Basis Document</td>
</tr>
<tr>
<td>CDR</td>
<td>Critical Design Review</td>
</tr>
<tr>
<td>CICS</td>
<td>Cooperative Institute for Climate Studies</td>
</tr>
<tr>
<td>CIMSS</td>
<td>Cooperative Institute for Meteorological Satellite Studies</td>
</tr>
<tr>
<td>CIOSS</td>
<td>Cooperative Institute for Oceanographic Satellite Studies</td>
</tr>
<tr>
<td>CIRA</td>
<td>Cooperative Institute for Research in the Atmosphere</td>
</tr>
<tr>
<td>CL</td>
<td>Checklist</td>
</tr>
<tr>
<td>CREST</td>
<td>Cooperative Remote Sensing and Technology Center</td>
</tr>
<tr>
<td>DG</td>
<td>Documentation Guideline</td>
</tr>
<tr>
<td>EOS</td>
<td>Earth Observing System</td>
</tr>
<tr>
<td>EPL</td>
<td>Enterprise Project Lifecycle</td>
</tr>
<tr>
<td>MTF</td>
<td>Modulation Transfer Function</td>
</tr>
<tr>
<td>NESDIS</td>
<td>National Environmental Satellite, Data, and Information Service</td>
</tr>
<tr>
<td>NOAA</td>
<td>National Oceanic and Atmospheric Administration</td>
</tr>
<tr>
<td>NPOESS</td>
<td>National Polar-orbiting Operational Environmental Satellite System</td>
</tr>
<tr>
<td>OOB</td>
<td>Out-of-Band</td>
</tr>
<tr>
<td>OSDPD</td>
<td>Office of Satellite Data Processing and Distribution</td>
</tr>
<tr>
<td>PAL</td>
<td>Process Asset Library</td>
</tr>
<tr>
<td>PDR</td>
<td>Preliminary Design Review</td>
</tr>
<tr>
<td>PRG</td>
<td>Peer Review Guideline</td>
</tr>
<tr>
<td>PSF</td>
<td>Point-Spread Function</td>
</tr>
<tr>
<td>STAR</td>
<td>Center for Satellite Applications and Research</td>
</tr>
</tbody>
</table>
1. INTRODUCTION

The NOAA/NESDIS Center for Satellite Applications and Research (STAR) develops a diverse spectrum of complex, often interrelated, environmental algorithms and software systems. These systems are developed through extensive research programs, and transitioned from research to operations when a sufficient level of maturity and end-user acceptance is achieved. Progress is often iterative, with subsequent deliveries providing additional robustness and functionality. Development and deployment is distributed, involving STAR, the Cooperative Institutes (CICS, CIMSS, CIOSS, CIRA, CREST) distributed throughout the US, multiple support contractors, and NESDIS Operations.

NESDIS/STAR is implementing an increased level of process maturity to support the exchange of these software systems from one location or platform to another. The Algorithm Theoretical Basis Document (ATBD) is one component of this process.

1.1. Objective

The objective of this Document Guideline (DG) is to provide the STAR standard for the ATBD. The intended users of this DG are the personnel assigned by the Project Lead to the task of creating a product ATBD.

1.2. The Algorithm Theoretical Basis Document

The purpose of the ATBD is to provide product developers, reviewers and users with a theoretical description (scientific and mathematical) of the algorithm that is used to create a product that meets user requirements. A separate ATBD is produced for each distinct product in the STAR Enterprise during the Basic Research, Focused R&D, Design Development and Code Development phases of the STAR Enterprise Product Lifecycle (EPL)\(^1\).

STAR EPL provides for two ATBD versions (v1 and v2). ATBD version 1 has one planned revision. ATBD version 2 has two planned revisions.

---

\(^1\) For a description of the STAR EPL, refer to the STAR EPL Process Guidelines (PG-1 and PG-1.A).
ATBD v1.0 is produced during the Basic Research phase of the STAR EPL. At this phase, 
the algorithm is at a “concept” stage and its operational potential has not been assessed.
The purpose of ATBD v1.0 is to demonstrate that the algorithm has operational potential 
and should be further developed to demonstrate operational capability. The intended target 
audience is other scientists and managers at the algorithm developer’s organization.

ATBD v1.1 is produced during the Exploratory phase of the STAR EPL. At this phase, the 
algorithm’s operational potential has been demonstrated to the satisfaction of the Research 
organization and is now being further developed to support a research to operations 
development proposal. The purpose of ATBD v1.1 is to demonstrate that the algorithm 
should be developed for transition to operations. The intended target audience is SPSRB 
and STAR scientists and managers.

ATBD v2.0 is produced during the Design phase of the STAR EPL as an artifact for the 
Preliminary Design Review (PDR)\(^2\). At this phase, the algorithm has been approved by 
STAR and is being further developed as a pre-operational product with oversight from 
STAR. The purpose of ATBD v2.0 is to demonstrate to the PDR reviewers that the 
algorithm requirements are well understood, well documented and achievable. The 
intended target audience includes STAR scientists and the PDR Reviewers.

ATBD v2.1 is produced during the Design phase of the STAR EPL as an artifact for the 
Critical Design Review (CDR). ATBD v2.1 is typically updated from the PDR version (v2.0), 
as detailed design provides additional maturity. The purpose of ATBD v2.1 is to help 
demonstrate to the CDR reviewers that the algorithm detailed design provides for an 
implementation that is consistent with the theoretical basis and meets requirements. The 
intended target audience includes STAR scientists and the CDR Reviewers.

ATBD v2.2 is the final planned ATBD version. It is produced during the Build phase of the 
STAR EPL as an artifact for the System Readiness Review (SRR). At this phase, the 
algorithm is in the final stages of pre-operational development. ATBD v2.2 is typically 
updated from the CDR version (v2.1), revising the performance estimates as a result of unit 
testing and system testing. The purpose of ATBD v2.2 is to help demonstrate to the SRR 
reviewers that the algorithm is ready for transition to operations. The intended target 
audience includes STAR scientists and the SRR Reviewers.

Additional revisions of the ATBD may be required during operations if a significant 
algorithm revision occurs for needed science maintenance.

The ATBD is prepared by the lead algorithm developer, with assistance from other 
scientists as assigned by the developers’ organization (v1) or the Development Lead (v2).

\(^2\) Refer to the STAR EPL Process Guidelines (PG-1 and PG-1.A) for a description of the STAR EPL gates 
and reviews.
The ATBD should be developed as a Microsoft Word document. Upon approval, the approved version of the ATBD may be converted to an Adobe pdf file for storage in the project artifact repository.

1.3. Background
This DG defines guidelines for producing an ATBD. This DG has been adapted from EOS and NPOESS practices. It has been tailored to fit the STAR EPL process.

1.4. Benefits
An ATBD developed in accordance with the standards in this DG ensures that the algorithm developers and reviewers have the information they need to verify that the algorithm is meeting project requirements. It is therefore a requirement that an ATBD be developed in accordance with the guidelines in this document before pre-operational code is approved for transition to operations.

1.5. Overview
This DG contains the following sections:

- Section 1.0 - Introduction
- Section 2.0 - Reference Documents
- Section 3.0 - Standard Table of Contents
- Section 4.0 - Section Guidelines
- Appendix A - Examples
- Appendix B - Templates
2. REFERENCE DOCUMENTS

All of the following references are STAR EPL process assets that are accessible in a STAR EPL Process Asset Repository (PAR) on the STAR web site:


PG-1: STAR EPL Process Guideline provides the definitive description of the standard set of processes of the STAR EPL.

PG-1.A: STAR EPL Process Guideline Appendix, an appendix to PG-1, is a Microsoft Excel file that contains the STAR EPL process matrix (Stakeholder/Process Step matrix), listings of the process assets and standard artifacts, descriptions of process gates and reviews, and descriptions of stakeholder roles and functions.

PRG-1: Gate 1 Review Guidelines are the guidelines for the Gate 1 Review. It is useful for the developer of ATBD v1.0 to understand what the reviewers will expect when reviewing the ATBD.

CL-1: Gate 1 Review Check List is the check list for the Gate 1 Review. It is useful for the developer of ATBD v1.0 to understand the specific check list items (CLI) that the reviewers of the ATBD will be required to approve.

PRG-3: Gate 2 Review Guidelines are the guidelines for the Gate 2 Review. It is useful for the developer of ATBD v1.1 to understand what the reviewers will expect when reviewing the ATBD.

CL-3: Gate 2 Review Check List is the check list for the Gate 2 Review. It is useful for the developer of ATBD v1.1 to understand the specific check list items (CLI) that the reviewers of the ATBD will be required to approve.

PRG-7: Preliminary Design Review Guidelines are the guidelines for the PDR. It is useful for the developer of ATBD v2.0 to understand what the reviewers will expect when reviewing the ATBD.
CL-7: Preliminary Design Review Check List is the check list for the PDR. It is useful for the developer of ATBD v2.0 to understand the specific CLI that the reviewers of the ATBD will be required to approve.

PRG-8.1: Critical Design Review Guidelines are the guidelines for the CDR. It is useful for the developer of ATBD v2.1 to understand what the reviewers will expect when reviewing the ATBD.

CL-8.1: Critical Design Review Check List is the check list for the CDR. It is useful for the developer of ATBD v2.1 to understand the specific CLI that the reviewers of the ATBD will be required to approve.

PRG-11.1: System Readiness Review Guidelines are the guidelines for the SRR. It is useful for the developer of ATBD v2.2 to understand what the reviewers will expect when reviewing the ATBD.

CL-11.1: System Readiness Review Check List is the check list for the SRR. It is useful for the developer of ATBD v2.2 to understand the specific CLI that the reviewers of the ATBD will be required to approve.

DG-0.1: STAR Document Style Guideline is a STAR EPL Document Guideline (DG) that provides STAR standards for the style and appearance of STAR documents developed as Microsoft Word files.


SG-14: STAR EPL Development Scientist Guidelines provides a description of standard tasks for Development Scientists, including development of ATBD v2.

TG-1: STAR EPL Basic Research Task Guidelines provides a description of standard tasks for process step 1, during which ATBD v1.0 is developed.

TG-3: STAR EPL Project Proposal Task Guidelines provides a description of standard tasks for process step 3, during which ATBD v1.1 is developed.

TG-7: STAR EPL Preliminary Design Task Guidelines provides a description of standard tasks for process step 7, during which ATBD v2.0 is developed.
TG-8: STAR EPL Detailed Design Task Guidelines provides a description of standard tasks for process step 8, during which ATBD v2.1 is developed.

TG-11: STAR EPL System Integration and Test Task Guidelines provides a description of standard tasks for process step 11, during which ATBD v2.2 is developed.
3. STANDARD TABLE OF CONTENTS

LIST OF FIGURES
LIST OF TABLES
LIST OF ACRONYMS
ABSTRACT

1.0 INTRODUCTION
1.1 Purpose of This Document
1.2 Who Should Use This Document
1.3 Inside Each Section
1.4 Related Documents
1.5 Revision History

2.0 OBSERVING SYSTEM OVERVIEW
2.1 Objectives of Retrieval
2.2 Instrument Characteristics
2.3 Retrieval Strategies

3.0 ALGORITHM DESCRIPTION
3.1 Processing Outline
3.2 Algorithm Input
   3.2.1 Primary Sensor Data
   3.2.2 Ancillary Data
   3.2.3 Forward Models and Look-Up Tables
3.3 Theoretical Description of Retrieval
   3.3.1 Physics of the Problem
   3.3.2 Mathematical Description
   3.3.3 Algorithm Output
3.4 Performance Estimates
3.4.1 Test Data Sets
3.4.2 Sensor Radiometric Noise Effects
3.4.3 Sensor Radiometric Calibration Effects
3.4.4 Sensor Spatial and Spectral Error Effects
3.4.5 Geophysical Effects
3.4.6 Error Budget

3.5 Practical Considerations
3.5.1 Numerical Computation Considerations
3.5.2 Programming and Procedural Considerations
3.5.3 Quality Assessment and Diagnostics
3.5.4 Exception Handling

3.6 Algorithm Validation
3.6.1 Pre-Launch Validation
3.6.2 Post-Launch Calibration and Validation

4.0 ASSUMPTIONS AND LIMITATIONS
4.1 Performance
4.2 Pre-Planned Product Improvements
  4.2.1 Improvement 1
  4.2.2 Improvement 2
  ......................
  4.2.N Improvement N

5.0 LIST OF REFERENCES
4. SECTION GUIDELINES

This section contains the STAR guidelines for each section of the ATBD.

The ATBD should follow the STAR standard for style and appearance, as stated in DG-0.1.

4.1. Table of Contents

The Table of Contents can be inserted by using Word’s Insert ➔ Reference ➔ Index and Tables ➔ Table of Contents function or by pasting the Table of Contents from this DG into your document and updating it for the section headers you make for your document. Use a page break if necessary to ensure that the Table of Contents appears at the top of a page.

4.2. List of Figures

A List of Figures should be provided after the Table of Contents. A page break should be used if necessary to ensure that the List of Figures appears at the top of a page. To create a List of Figures, use Word’s Insert ➔ Reference ➔ Index and Tables ➔ Table of Figures function, selecting the “Table of Figures” Style. Alternatively, the List of Figures can be created by pasting the List of Figures for this DG into your document.

Figures should be created by using Word’s Insert ➔ Picture ➔ From File function or Word’s Insert ➔ Object function. Figures should be numbered X.Y, where X is the main section number where the figure resides and Y = 1,N is the ordered number of the figure in the section. Figure captions should have Arial bold 12 point font, should be center justified, and should have a “Table of Figures” Style. A Figure Caption template is provided in Appendix B of this DG.

4.3. List of Tables

A List of Tables should be provided after the List of Figures. The List of Tables can appear on the same page as the List of Figures, with three blank lines separating them, provided both lists can fit on the same page. If both lists cannot fit on the same page, a page break should be used to ensure that the List of Tables appears at the top of a page.
To create a List of Tables, use Word’s Insert ➔ Reference ➔ Index and Tables ➔ Table of Figures function, selecting the “Table - Header” Style. Alternatively, the List of Tables can be created by pasting the List of Tables for this DG into your document.

Tables should be created with the Table ➔ Insert ➔ Table function. Tables should be numbered X.Y, where X is the main section number where the table resides and Y = 1,N is the ordered number of the table in the section. Table titles should have Arial bold 12 point font, should be center justified, and should have a “Table - Header” Style. A Table Title template is provided in Appendix B of this DG. Table text should have Arial regular 10 point font.

4.4. List of Acronyms

The use of acronyms is encouraged. A two word or longer name for an item (e.g., Research Project Plan) should be given an acronym (e.g., RPP) if the name is used more than once in the document. A List of Acronyms should be provided after the List of Tables. The List of Acronyms should be in alphanumeric order. Use the List of Acronyms in this DG as a template. A page break should be used if necessary to ensure that the List of Acronyms appears at the top of a page.

4.5. Abstract

The ATBD shall include an Abstract. The Abstract shall precede Section 1 and shall have a “Header 1” Style (c.f., Section 3.9 of this DG). The Abstract should provide an overview of the ATBD at a level of detail sufficient to enable a potential reader of the ATBD to determine whether it is of interest to him. The Abstract is not intended for the use of relevant STAR EPL stakeholders, who should read the entire document. It is instead intended for the use of potentially interested outside users of the product.

4.6. Section 1 – Introduction

The ATBD shall include an Introduction Section. This section shall include:

- A well-defined purpose and function for the document
- Specific intended user(s)
- How the intended user(s) should use the document
- A responsible entity for generating the document
• A responsible entity for review/approval of the document
• A responsible entity for storage, accessibility, and dissemination
• A brief overview of the contents of each main section
• A revision history

• A “Purpose of This Document” subsection should explain the intended use of this document, including an identification of the retrieval or product.

• A “Who Should Use This Document” subsection should identify the intended users with as much specificity as possible (e.g., “STAR Sensor Physics Branch Lead”, STAR EPL SRR reviewers”) and should explain how each of the specified users should use this document. The intended usage can vary for various users; the ATBD developer should refer to the appropriate Work Instruction (c.f., Section 2 of this document) for guidance.

• An “Inside Each Section” subsection should describe the scope of each ATBD main section. Usually, one sentence per section will suffice (see example ATBD).

• A “Related Documents” subsection should consist of a list of any important documents related to the ATBD, and their complete citations including access information.

• A “Revision History” subsection should consist of a list of all revisions to this ATBD, including author of revision, description of revision, motivation for revision, and revision number and date.

4.7. Section 2 – Observing System Overview

Include an overview of the algorithm system with objectives, characteristics of the instrument(s) that provides the input data and retrieval strategies.

• An “Objectives of Retrieval” subsection should describe the objectives of the algorithm, including the intended output data products and their intended use.

• An “Instrument Characteristics” subsection for should describe the attributes of the sensing system(s) used to supply data for the retrieval algorithm at a level of detail sufficient for reviewers to verify that the instrument is capable of supplying input data of sufficient quality.
• A “Retrieval Strategies” subsection should describe the fundamental approach for retrieval at a level of detail sufficient for reviewers to determine that the algorithm theoretical description is adequate.

4.8. Section 3 – Algorithm Description

Include a complete description of the algorithm at the current level of maturity (which will improve with each revision).

• A “Processing Outline” subsection should fully describe the processing outline of the retrieval algorithm. All key elements and sub-elements needed to convey a comprehensive sense of the algorithm should be included. The level of detail should be consistent with the current maturity of the software architecture (which will improve with each revision). A data flow diagram is desirable, provided it is consistent with the software architecture.

• An “Algorithm Input” subsection should fully describe the attributes of all input data used by the algorithm, including primary sensor data, ancillary data, forward models and look-up tables. Do not include file formats; these are documented elsewhere.

• A “Theoretical Description of Retrieval” subsection should comprehensively describe the physics, radiative transfer, and associated phenomenology key to the retrieval in a “Physics of the Problem” subsection. It should also comprehensively describe the mathematics used by the retrieval, including all simplifications, approximations, and numerical methods, in a “Mathematical Description of the Algorithm” subsection.

• An “Algorithm Output” subsection should describe the data products that will be produced by the algorithm.

• A “Performance Estimates” subsection should comprehensively describe the predicted algorithm performance and quality of the products at a level of detail appropriate for the current algorithm maturity.
  o A “Test Data Sets” subsection should describe the test data sets used to characterize the performance of the algorithm and quality of the data product(s), including the breadth of the domain (typical versus stressing states) used in the analysis and assessment.
A “Sensor Radiometric Noise Effects” subsection should characterize the flowed-through effects of radiometric noise on the quality of retrieval products, using text and graphics (scatter plots, image displays, etc.).

A “Sensor Radiometric Calibration Effects” subsection should characterize the flowed-through effects of radiometric calibration errors (including structured scenes and response versus scan, etc) on the quality of retrieval products, using text and graphics.

A “Sensor Spatial and Spectral Error Effects” subsection should characterize the flowed-through spatial and spectral error effects (modulation transfer function (MTF), point-spread function (PSF), out-of-band (OOB) response, near-field stray light, Earth shine, solar contamination, polarization, cross talk, etc.) on the quality of retrieval products, using text and graphics.

A “Geophysical Effects” subsection should characterize the flowed-through effects of un-modeled or neglected physical phenomena on the retrieval products on the quality of retrieval products, using text and graphics.

An “Error Budget” subsection should organize the various error estimates into an error budget, presented as a table. Error budget limitations should be explained. Describe prospects for overcoming error budget limitations with future maturation of the algorithm, test data, and error analysis methodology.

A “Practical Considerations” subsection should review issues involving numerical computation, programming and procedures, quality assessment and diagnostics and exception handling at a level of detail appropriate for the current algorithm maturity.

A “Numerical Computation Considerations” subsection should describe in sufficient depth how the algorithm is numerically implemented, including any possible issues with computationally intensive operations (e.g., large matrix inversions).

A “Programming and Procedural Considerations” subsection should describe any important programming and procedural aspects related to implementing the numerical model into operating code.

A “Quality Assessment and Diagnostics” subsection should describe how the quality of the output products and the retrieval itself is assessed, documented, and any anomalies diagnosed.

An “Exception Handling” subsection should list the complete set of expected exceptions, and describes how they are identified, trapped, and handled.
• An “Algorithm Validation” subsection should describe how the algorithm has been or will be validated at a level of detail appropriate for the current algorithm maturity.
  o A “Pre-Launch Validation” subsection should describe how the algorithm has been or will be validated before actual flight data are available, using a mixture of proxy and synthetic simulated data.
  o A “Post-Launch Calibration and Validation” subsection should describe how the algorithm has been or will be calibrated and validated using actual flight data.

4.9. Section 4 – Assumptions and Limitations

Describe all assumptions that have been made concerning the algorithm’s theoretical basis and performance estimates that cannot be verified at the current time. Describe any potential limitations in the intended use of the algorithm and its products.

• A “Performance” subsection should describe all assumptions that have been made concerning the performance estimates. To the extent possible, the potential for degraded performance should be explored, along with mitigating strategies.
• A “Pre-Planned Product Improvements” subsection should describe potential future enhancements to the algorithm, the limitations they will mitigate, and provide all possible and useful related information and links. This subsection should be organized into separate subsections for each potential enhancement, ordered according to a combination of highest operational priority and greatest feasibility.

4.10. Section 5 – List of References

Include all references cited in the ATBD. References should be listed in alphabetical order. References that begin with an author list should begin with the last name of the lead author. A template is provided in Appendix B.
APPENDIX A - EXAMPLES

An example of an ATBD that follows the STAR standards and guidelines will be developed and made accessible from the STAR Process Asset Repository (PAR).
APPENDIX B - TEMPLATES

This appendix contains templates for specific pages and sections of the ATBD.
B.1 Cover Page Template:
In this template, <X> = 1.0 for v1r0, <X> = 1.1 for v1r1, <X> = 2.0 for v2r0 etc. <Project Name> should be the actual approved name of the Project.
B.2 Document Header Template:
In this template, \(<X>\) = 1.0 for v1r0, \(<X>\) = 1.1 for v1r1, \(<X>\) = 2.0 for v2r0 etc.

In this template, \(<\text{Project Name}>\) should be the actual approved name of the Project.

In this template, \(<Y>\) = the actual page number.

In this template, \(<Z>\) = the actual total number of pages

B.3 Document Cover Page Footer Template:

B.4 Document Footer Template:
B.5 Version History Page Template:
In this template, \(<X> = 1.0\) for v1.0, \(<X> = 1.1\) for v1.1, etc. \(<\text{Project Name}>\) should be the actual approved name of the Project.

**TITLE:** <\text{PROJECT NAME}> ALGORITHM THEORETICAL BASIS DOCUMENT VERSION <\X>

**AUTHORS:**

<Lead Author>

<Co-Author 1>

<etc.>

<table>
<thead>
<tr>
<th>Version</th>
<th>Description</th>
<th>Revised Sections</th>
<th>Date</th>
</tr>
</thead>
</table>

<\text{PROJECT NAME}>
ALGORITHM THEORETICAL BASIS DOCUMENT
VERSION HISTORY SUMMARY
<table>
<thead>
<tr>
<th></th>
<th>Created by &lt;Name of Developer(s)&gt; of &lt;Name of Developers' Organization/Company&gt; to describe Basic Research algorithm</th>
<th>New Document</th>
<th>&lt;Actual date of Latest approval signature&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>Revised by &lt;Name of Developer(s)&gt; of &lt;Name of Developers' Organization/Company&gt; to describe Focused Research algorithm</td>
<td>All</td>
<td>&lt;Actual date of Latest approval signature&gt;</td>
</tr>
<tr>
<td>1.1</td>
<td>Revised by &lt;Name of Developer(s)&gt; of &lt;Name of Developers' Organization/Company&gt; to add preliminary design elements.</td>
<td>2, others possible</td>
<td>&lt;Actual date of Latest approval signature&gt;</td>
</tr>
<tr>
<td>2.0</td>
<td>Revised by &lt;Name of Developer(s)&gt; of &lt;Name of Developers' Organization/Company&gt; to add detailed design elements</td>
<td>3.1, 3.2, others possible</td>
<td>&lt;Actual date of Latest approval signature&gt;</td>
</tr>
<tr>
<td>2.1</td>
<td>Revised by &lt;Name of Developer(s)&gt; of &lt;Name of Developers' Organization/Company&gt; to add test results and confirm that operational requirements on the algorithm have been met.</td>
<td>3.4, 3.5, 3.6, others possible</td>
<td>&lt;Actual date of Latest approval signature&gt;</td>
</tr>
<tr>
<td>2.2</td>
<td>[As needed] Revised by &lt;Name of Developer(s)&gt; of &lt;Name of Developers' Organization/Company&gt; to describe science maintenance changes</td>
<td>&lt;applicable sections&gt;</td>
<td>&lt;Actual date of Latest approval signature&gt;</td>
</tr>
</tbody>
</table>

etc.
B.6 Figure Caption Template:

Figure 2.3 - <Figure caption in Arial regular 12 point font>

B.7 Table Title Template:

Table 4.5 - <Table title in Arial regular 12 point font>
B.8 List of References Template:


END OF DOCUMENT